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1.1 Introduction
Welcome to the LiNX Access PC tool user manual. The LiNX Access PC tool is an application
for Windows PCs and laptops, and is used for:

l configuring the Dynamic Controls range of LiNX wheelchair controllers
l viewing real-time and historical diagnostic information

1.2 Using this manual
This manual will help you to understand, install, and use the LiNX Access PC tool.

This manual uses the following information boxes to convey important and useful
information:

Warning
Warnings provide important information that must be followed in order to install, configure, and use the product
safely and efficiently. Not following the instructions given in a warning can potentially lead to equipment failure,
damage to surrounding property, injury or death.

Note
Notes provide supporting information in order to install, configure, and use the product. Not following the
instructions given in notes or precautions can lead to equipment failure.

See also
The "See also" box provides cross-references to help you navigate the installation manual more easily.

1.3 Important information
Due to a policy of continuous product improvement, Dynamic Controls reserves the right to
update this product and manual without notice. This issue of the manual supersedes all
previous issues. Previous issues must not be used.

The latest version of this manual can be downloaded from Dynamic Controls' website
at www.dynamiccontrols.com

1.4 Copyright, trademarks and acknowledgements
Dynamic Controls, the Dynamic logo and the LiNX logo are trademarks of Dynamic Controls.
All other brand and product names, fonts, and company names and logos are trademarks or
registered trademarks of their respective companies.
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Dynamic Controls owns and will retain all trademark rights; and Dynamic Controls or its
licensors own and will retain all copyright, trade secret and other proprietary rights, in and
to the documentation.

All materials contained within this manual, in printed or electronic format, are protected by
copyright laws and other intellectual property laws.

iPhone, iPod touch, iPad and iTunes are trademarks of Apple Inc., registered in the U.S. and
other countries.

The Bluetooth® word, mark, and logos are registered trademarks owned by Bluetooth® SIG,
Inc., and any use of such marks by Dynamic Controls is under license.

© Copyright 2013–2024 Dynamic Controls. All rights reserved
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1.6 Glossary

A

Access Key
A Bluetooth programming adaptor that plugs into the XLR connector of the remote
module. See also: Pairing (Bluetooth) and Connection (Bluetooth).

C

Connection (Bluetooth)
The process of linking two Bluetooth devices together each time they are within
range of each other and data is about to be exchanged between them. This process
occurs after the devices have paired - see Pairing (Bluetooth).

CWD
Centre wheel drive.

E

EMC
Electromagnetic compatibility.

ESD
Electrostatic discharge.

F

FWD
Front wheel drive.

I

iOS
Operating system used by portable Apple devices such as iPhone, iPad, and iPod
touch.

L

LED
Light emitting diode
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O

OBC
On-board charger — a battery charger that is permanently wired to the power mod-
ule via the utility connector.

OEM
Original equipment manufacturer.

OON
Out Of Neutral — a safety condition to prevent: 1) the wheelchair driving if the
remote module's joystick is not in the central/neutral position when the system is
powered up or after a function change, or, 2) a seating motion if the seating
motion's control input is in its activated state when the system is powered up or
after a function change.

P

P&D tools
This term refers to the programming and diagnostic tools: LiNX Access iOS and LiNX
Access PC.

Pairing (Bluetooth)
Pairing is the process of establishing a connection between two Bluetooth devices
(e.g. a LiNX Access Key and an iPhone or a PC) for the FIRST time. Compare "Con-
nection (Bluetooth)".

PIN
Personal identification number.

R

RWD
Rear wheel drive.

S

S-curve processing
This describes Dynamic Controls' software processing techniques to provide the
user with a smooth and controllable response when changing speed input
demands. S-curve processing is responsible for all soft start accel-
eration/deceleration, soft finish acceleration/ deceleration, including forward,
reverse and turn movements.
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U

User input
A generic term to describe any input device that operates a user function such as
driving or seating. This includes, but not limited to, a remote module's joystick, a
switch array (such as a head array) and a buddy button.
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2.1 What it does
The LiNX Access PC tool connects wirelessly
to a LiNX wheelchair controller to:

l read and write control configurations
l display diagnostic information

Figure 1:  LiNX Access PC tool

2.2 Features
l Move easily between wheelchair and files
l Instant wireless programming (live edit) and

diagnostics
l Numeric, graphic and text parameter input

l Intuitive, user-friendly
interface

l 10m working range

2.3 Version information
2.3.1 The LiNX Access PC tool
This manual has been written for the LiNX Access PC tool, version 2024.1.0 and later. For
information regarding the previously released versions, please see the downloads section
on the Dynamic Controls website: www.dynamiccontrols.com

2.3.2 LiNX Systems
The LiNX Access PC tool has been designed to support all versions of the LiNX family of
wheelchair controllers.

Warning
Performance adjustments must only be made by healthcare professionals or by persons who completely
understand the adjustment process and the capabilities of the wheelchair user.

Before upgrading the firmware of the system, or a module in the system, always ensure that the battery charge
level is sufficient and the park brakes are not manually or electronically released.

Incorrect settings, or programming in a location that is not safe, can cause injury to the user and bystanders, or
damage to the wheelchair and surrounding property.

After you have configured the wheelchair, check to make sure that it performs to the specifications entered in the
programming procedure. If the wheelchair does not perform to specifications, reprogram it. Repeat this
procedure until the wheelchair performs to specifications. If the wanted operation cannot be reached, contact
your service agent.

Ensure that the deceleration parameters are always higher than the acceleration parameters for a safe response.
It is the responsibility of the health care professional to make sure that the user is capable of both cognitively
understanding and physically operating the programmed features and functions.

With inappropriate programming settings, certain features and options may not be accessible or perform as
expected.

Where any inconsistencies about chair status occur between the LiNX System and that reported by a
programming tool, the user should take the status as reported by the LiNX System as correct.
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3.1 System requirements
To use the LiNX Access PC tool, you need a:

l copy of the tool's installation software
l LiNX wheelchair control system
l LiNX Access Key
l PC or laptop with a Bluetooth connection

The LiNX Access PC tool operates on Windows 10 64-bit, and later.

The minimum PC specifications are:

Screen resolution 1024 × 768 px

Processor
2.4 GHz Dual Core

CPU
Free space on hard
drive

4 GB

Memory (RAM) 2 GB
Bluetooth 3.0

3.2 Installing the software
Download the latest LiNX Access PC installer (.msi file) software from the Dynamic Controls
website at www.dynamiccontrols.com. Double-click the downloaded installer file and follow
the on-screen instructions.

Step 1—select language for installation

1. Select your choice of language from
the drop-down box.

2. Click OK to continue.

Figure 2: Select the language to use during installation
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Step 2—accept conditions of use

Before proceeding, read and fully
understand the Conditions of Use and
Warnings in this dialogue.

1. Select I accept.
2. Click Next.

Figure 3: Accept conditions of use

Step 3—select destination folder

Save the application to the suggested
folder or to an alternative folder.

To save to the suggested folder, click
Next to continue.

To save to an alternative folder:
1. Click Browse and select a

different folder.
2. Click Next to continue.

Figure 4:  Destination folder screen

Step 4—select Start Menu folder

Save the application's shortcuts to the
suggested Start Menu folder or to an
alternative folder.

To save to the suggested folder, click
Next to continue.

To save to an alternative folder:
1. Click Browse and select a different

folder.
2. Click Next to continue. Figure 5:  Start menu folder screen
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Step 5—select additional icons and tasks

By default, a desktop icon is added for
the LiNX Access PC tool, and the
wheelchair program file (*.lci) is
associated with the tool.

1. Check / uncheck the options, as
required.

2. Click Install.

Figure 6: Select additional tasks

Step 6—finish

Click Finish to complete the installation.

Figure 7: Finish screen

3.3 Checking and getting the latest version
To view the installed version of the tool, click
Help | About from the menu bar.

To get the latest version of the tool:
l click Help | Check for updates; or
l check the Dynamic Controls website at

www.dynamiccontrols.com

Figure 8: About screen

Note
An Internet connection is required when checking for updates. If an Internet connection is unavailable, the
following message is displayed:

Failed to check for updates. The software was unable to connect to the Internet. Please check
that your network settings are correct and try again.
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If your computer uses a proxy server to connect to the internet, you will need to configure your network settings—
see 5.8.1 Configure Internet settings.

If Internet access is available but the LiNX Access PC tool is not able to check for updates, it is possible that your
organisation's network policy does not permit connections to unapproved websites. In this case you will need to
have the following URL added to your organisation's network whitelist: https://mage.dynamiccontrols.com/

3.4 The LiNX Access Key
A LiNX Access Key (LAK) is required for the LiNX Access PC
tool to communicate via Bluetooth with a LiNX system. Two
versions of the LiNX Access Key are available: a
manufacturer version, and a distributor version. The
version determines your level of access to programming
functions.

Figure 9: LiNX Access Keys

l Distributors: Providers, dealers, therapists and wheelchair service agents (DLX-
HKEY01-A (orange label in Figure 9))

l Manufacturers: OEMs and certain service agents (DLX-HKEY02-A (green label in
Figure 9))

See 5.8.6 View as manufacturer or distributor for further information.
The key plugs directly into the remote module's XLR connector.

Figure 10: Inserting the LiNX Access Key (top: low profile remote module, middle: REM1xx, 2xx, bottom:REM400)
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3.5 Using Bluetooth on a computer
You will need a Bluetooth connection to communicate between the LiNX Access PC tool
and a LiNX system.

Use a computer's built-in Bluetooth function (usually found on laptops) or an external USB
Bluetooth adaptor.

3.5.1 Using built-in Bluetooth
If your computer has a built-in Bluetooth module (usually, but not exclusively found on
laptops), you will need to enable it. To do this:

Figure 11: Select
Settings

1. Right-click on the Windows
Start button and select Settings
from the menu — Figure 11.

2. Click on Devices — Figure 12.

3. Click on Bluetooth and other
devices — Figure 13.

4. Set the Bluetooth toggle
button to On — Figure 13.

Figure 12: Click on Devices

Figure 13: Bluetooth toggle button

3.5.2 Using an external USB Bluetooth adaptor

Figure 14:
Example USB
Bluetooth
adaptor

If your computer has no Bluetooth capability, plug an external USB Bluetooth
adaptor (Figure 14) into a USB port. The Windows operating system will
detect and install the appropriate drivers for the adaptor. 

DO NOT install any drivers provided with the adaptor.
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This chapter gives an overview of the tool, what it does and how to find your way around it.

4.1 Programming contexts
The LiNX Access PC tool has two programming contexts:

l Connection context: access and program a system while directly connected to the
LiNX system on a wheelchair

l File context: access and edit a program stored as a file on your device

4.1.1 Viewing the contexts
The LiNX Access PC tool uses tabs to display the contexts:

l The connection context is always under the left-most tab
l All other tabs (to the right of the connection tab) are used for files

To switch between connection context and file context, simply click the appropriate tab.

Figure 15: Tab bar with connection and file contexts

4.2 Modifying a program
Programs can be modified in one of two modes:

l Live edit
l Bulk edit

They define when parameters are written to the wheelchair.

4.2.1 Live edit
Live edit is available in the connection context only — that is, when connected to a
wheelchair.

Live edit writes and applies parameter changes immediately to the wheelchair as you enter
them. This is useful for quickly setting up and testing.
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When in live edit, only live edit parameters can be edited. Live edit parameters are
identified by a circular icon next to the parameter name.

When a live edit parameter is edited the icon momentarily changes to a filled circle to
indicate it has been updated.

Figure 16: Live edit parameter change indication

Warning
In live edit, changes to parameters take immediate effect, changing the wheelchair's performance immediately.

Warning
There is no function to undo a change in live edit. Save a copy of the existing program before live editing to
enable you to restore settings if required.

4.2.2 Bulk edit
Bulk edit is available in connection context and file context.

In bulk edit, all parameters are editable but none are written to the wheelchair
immediately. They are written to the wheelchair when the Write function is selected.

In file context, all parameters are bulk edit parameters.

In connection context, bulk edit parameters are identified by a blue background and must
be unlocked to be editable.

You can unlock bulk edit in one of three ways:
1. Click on the Unlock button located at the top-left of the screen — Figure 17.

Figure 17: Unlocking bulk edit #1

2. Open any bulk edit parameter and click Unlock — Figure 18.
3. Use the keyboard shortcut Ctrl + B.
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Figure 18: Unlocking bulk edit #2

After clicking Unlock, the LiNX Access PC
tool switches over from live edit to bulk
edit, and all parameters become editable.

When a parameter is modified in bulk edit,
its background colour changes to yellow.
The yellow background reverts to white
when you write it to the wheelchair or save
the file.

Figure 19:  Bulk edit parameter change indication

4.2.3 Working with live edit and bulk edit
By default, live edit is enabled every time the system is powered on and connected to the
LiNX Access PC tool (including after a write and power cycle). The application remains in
live edit until bulk edit is unlocked. When bulk edit is unlocked, the application switches to
bulk edit and live edit is disabled. The application remains in bulk edit until the system is
written to and power-cycled.

Figure 20: Working with live edit and bulk edit modes
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4.3 Screens, screen bars and menus

4.3.1 Screen layout overview

Figure 21:  LiNX Access PC structure and features

Figure 21 shows the typical layout of
the LiNX Access PC tool: the primary
navigation sidebar on the left, and the
main content area on the right.

The displayed contents depend on
what is selected from the primary (or
secondary, if relevant) navigation bar,
as shown in Figure 22.

For further information about the
primary and secondary navigation
sidebars, see Primary and secondary
navigation sidebars.

Figure 22: Primary and secondary navigation bars
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4.3.2 Menu bar
The menu bar is located at the top-left of the tool.
Each menu item is described next. Figure 23: Main menu

File
Menu item Function
Open File Open a program to edit
Import Firmware Open a dialog to select a firmware file
Save Save active program (as a file)
Save As... Save active program (as a file) with a different name
Export CSV Export parameter settings to CSV file
Convert Configuration Convert current configuration to newer version
Authorise Computer Permit computer to edit files offline
Create Bundle File Create a file containing configurations and/or firmware upgrades
Open Bundle File View and write a bundle file
Quit Close the application

Edit
Menu item Function
Add Module Add a LiNX module to your configuration
Add Motion Add a new motion to your configuration
Add Position Add a new memory position to your configuration
Add Angle Source Add a new angle source to your configuration
Add Trigger Angle Add a new trigger angle to your configuration

Calibrate
Menu item Function
Adaptive Load Compensation Use this option to enable the system to assess the chair's motor

loadings in order to give more consistent motor speed
Gyro Use this option to set the correct gyro values to maximise the chair's

control performance
Sip and Puff Use this option to calibrate the chair's sip and puff controls
Joystick shaping Use this option to set the joystick's maximum deflection in each

quadrant

View
Menu item Function
View as Manufacturer Display settings available for OEMs (this menu item is available only to

OEMs)
View as Distributor Display settings available for providers, dealers, therapists
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Help
Menu item Function
Check for Updates Check online for application updates
Internet Settings Set proxy settings
Set Application Language Choose language for UI
Enter Firmware Upgrade
Mode

Access the firmware upgrade screen (It is also accessible from the
System Summary button)

Support Request Access support contact details. Automatically create log file to send
to support team

About Display application information

4.3.3 Tab bar
When a wheelchair connection or file is open, the Tab bar displays. The Tab bar lets you
open and quickly access a connection or files.

Figure 24:  Tab bar showing connection and file tabs

4.3.3.1 Connection tab
The connection tab is fixed to the left edge of the application and is always visible, even
with no connection active.

Selecting this tab shows the current connection, or a list of available connections.

The text in the connection tab shows a connection's LAK serial number or, if set, its friendly
name. If there is no connection, the words Open a Connection display.

4.3.3.2 File tab
File tabs are to the right of the connection tab. Any number of files can be open at any one
time.

Each open file has its own tab. Closing a file closes the tab. The tab text is the file name and
extension. If the name is too long for the tab, an ellipsis (...) displays.

Note
If parameters under a tab change, an asterisk (*) is appended to the tab's text (ie. filename.lci*) until the
changes are saved.

When neither a file nor connection is open, the context view displays (See " Context selection window" on page
38). This is a split screen view with the connection context on the left and the file context on the right.
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4.3.4 Toolbar

4.3.4.1 Toolbar overview
The toolbar's display depends on:

l the context (connection or file)
l whether it is connected to a system
l whether it is in live edit or bulk edit mode

Toolbar section Displays (where relevant)

Left hand
l the connection state (as an animated, circular, edit status icon)
l a connection mode description, or,
l the read and write buttons

Middle

l the function action options
l the program name
l an option to reset the wheelchair to default settings
l an option to manage the wheelchair configuration

Right hand
l a file save as option
l an option to close the current connection

4.3.4.2 The edit status icon
The edit status icon describes the current edit mode.

Figure 25: Live
edit

Live edit — icon pans
from right to left with a
wave motion Figure 26:  Not

connected

Disconnected — icon
is greyed out and not
animated

Figure 27: Bulk
edit

Bulk edit mode — icon
sways left and right
with a flat horizon Figure 28:

Powered off

Powered off — icon is
not animated

4.3.4.3 Connection context on the toolbar
Figure 29 shows the toolbar when connected to a wheelchair and in live edit mode. The
icon is animated. The text "LIVE EDIT MODE" displays.

Live edit is the default mode on connection.

Figure 29:  Toolbar - connection context - live edit
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Figure 30 shows the toolbar when connected to a wheelchair and in bulk edit mode. The
icon is animated and the read and write buttons display.

Figure 30: Toolbar - connection context - bulk edit

Figure 31 shows the toolbar when connected to a wheelchair and the chair has been
powered off. The icon is not animated. The description displays "POWERED OFF". (When
you power on, your connection is automatically reinstated.)

Figure 31: Toolbar - connection context - powered off

Figure 32 shows the toolbar when there is no connection to a wheelchair. The icon is
greyed out and not animated. The description displays "NOT CONNECTED".

Figure 32: Toolbar - connection context - no connection
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4.3.4.4 File context on the toolbar
Figure 33 shows the toolbar when editing a file and in bulk edit mode. The icon is animated
and the read and write buttons display.

Figure 33: Toolbar - file context - bulk edit

Figure 34 shows the toolbar when editing a file in bulk edit mode and the chair has been
powered off. The icon is not animated. The description displays "POWERED OFF". (When
you power on, the PC LiNX Access tool returns to the previous connection in live edit
mode.)

Figure 34: Toolbar - file context - powered off

Figure 35 shows the toolbar when editing a file when there is no connection to a
wheelchair. The icon is greyed out and not animated. The description displays
"NOT CONNECTED".

Figure 35: Toolbar - file context - no connection
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4.3.5 Context tab mode
The context tab mode appears on the top, left-hand side of the screen under the toolbar.
The information it displays depends on the context (connection or file) — see Figure 36 and
Figure 37.

Figure 36: Context tab: connection mode Figure 37:  Context tab: file mode

In connection mode, the information displayed is:
l Connection context icon: a wheelchair icon
l LAK serial number or friendly name: friendly name is displayed if it has been

entered, otherwise the LAK's serial number is displayed (see 5.8.2 Set friendly name).
l System name: the name of the system (see 5.5.4 Change the system and program

name)
l Navigation restriction information: click on the information link to reveal what

navigation restrictions are placed on the system. The information displayed depends
on the modules in the system. See the LiNX Systems Installation Manual for more
information about navigation restrictions.

l Configuration version: displays the version of the system's current configuration.

In file mode, the information displayed is:
l File context icon: a file icon
l File name: the name of the current program file
l System name: the name of the system (see 5.5.4 Change the system and program

name)
l Navigation restriction information: click on the information link to reveal what

navigation restrictions are placed on the system. The information displayed depends
on the modules in the system. See the LiNX Systems Installation Manual for more
information about navigation restrictions.

l Configuration version: displays the version of the system's current configuration.
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4.3.6 Primary and secondary navigation sidebars
The primary and secondary navigation sidebars (see Figure 22 and Figure 38) enable you to
drill into the system's functions and parameters and display them in the Main content area.

Figure 38:  Primary
navigation sidebar

The primary sidebar always displays on the left-hand side of the
application.

The secondary sidebar displays only for certain primary navigation
selections and appears to the right of the primary navigation sidebar.

Home is the default selection on the primary sidebar. Home displays
the system dashboard in the main content area.

To view parameters, click a menu item below Home. The information displays in the main
content area.

4.3.6.1 Invalid values
A white arrow in a red circle next to an item on the primary navigation sidebar indicates an
invalid value.

To reach the invalid value, click the item and follow the arrows that appear. Edit the value
as required.

Figure 39:  Red arrow navigation to invalid values

4.3.7 Filter parameters box
The filter parameters box is at the bottom of
the primary navigation sidebar.

Use it like a search function to quickly locate
parameters. (See 5.5.9 Searching.)

Figure 40: Filter parameters box
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4.3.8 Main content area
The main content area displays information from a selected menu item on a navigation
sidebar (primary or secondary).

Figure 41 below shows two examples of main content area information: the home screen's
dashboard and a power module screen.

Figure 41: Home screen and power module screen

4.3.9 Utility screens
Utility screens display only when particular hardware or features are available.

Four utility screens are currently available in the LiNX Access tool:
l Adaptive Load Compensation (ALC) calibration
l Gyro calibration
l Sip and Puff calibration
l Joystick shaping

Access the four utility screens from the Calibrate menu in the Menu bar and then follow the
instructions on the selected screen.

Figure 42: Calibrate menu
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4.3.9.1 Adaptive load compensation (ALC) calibration
The Adaptive Load Compensation (ALC) calibration utility
calculates motor resistance values to help provide a
consistent motor speed.

See also
5.3.10 Tune adaptive load compensation (ALC)

Figure 43: ALC calibration screen

4.3.9.2 Gyro calibration
The Gyro calibration utility helps you set up a gyro module.

A gyro module must be connected to the system to make
this utility available.

See also
5.3.9 Tune the gyro

Figure 44: Gyro calibration screen

4.3.9.3 Sip and puff calibration
Sip and puff calibration lets you set sip and puff thresholds via
your input module.

An input module must be connected to the system to make this
utility available.

See also
5.3.11 Calibrate sip and puff

Figure 45: Sip and puff
calibration screen
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4.3.9.4 Joystick shaping calibration
Joystick shaping lets you reduce the extent
the joystick has to be deflected to reach full
demand in one or more quadrants.

See also
5.3.12 Joystick shaping

Figure 46: Joystick shaping calibration screen
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5.1 Open the LiNX Access PC tool

1. Open the LiNX Access PC tool on your PC or laptop using the installed shortcut or
icon. A disclaimer displays.

2. Read the disclaimer and click I Agree to continue.

Figure 47: Disclaimer displayed when opening the application

Warning
When using the LiNX Access PC tool, the user of the LiNX Access PC tool must:

l ensure that programming has completed correctly, and verify that the program has written as requested;
l test vehicle safety after programming;
l ensure that the user is capable of understanding and driving the vehicle.

By clicking on "I Agree" in the disclaimer (see Figure 47), the user of the LiNX Access tool understands that
these responsibilities and risks are accepted by them.

Note
If this is the first time that the LiNX Access PC tool application has been opened since installation, when you click
on the I Agree button (Figure 47, above), a Windows Security Alert dialogue box (Figure 48) may appear stating
that Windows Firewall has blocked some network features for this application. This is normal. To continue, select
the appropriate networks that you wish to operate on and then click on the Allow access button.

GBK54033 LiNX Access PC
User Manual Issue 12

How to... - Page 37



GBK54033 LiNX Access PC
User Manual Issue 12

Figure 48: Windows security alert

5.2 Select the context
After opening the application, the context selection screen displays. It has two tabs:

l Open a connection (left-hand tab): connect to a wheelchair through a LiNX Access
Key (LAK) — this is the connection context.

l Open a file (right-hand tab): access a file stored on your computer — this is the file
context.

Figure 49: Context selection window

Note
Double-click a connection or file to open it.
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5.3 Connection context tasks
The following tasks apply to the connection
context — that is, when you are working on a
connected wheelchair. (For file context
tasks, see 5.4 File context tasks.)

5.3.1 Connect to a wheelchair
To connect the LiNX Access PC tool with the wheelchair:

1. Power up a LiNX wheelchair system.
2. Insert a LAK into the remote module's XLR port.
3. Open the LiNX Access PC tool application. (See 5.1 Open the LiNX Access PC tool.)
4. From the Open a connection tab, either:

l select a LAK from the PAST CONNECTIONS list;
l click the Find more button (top left) to force the application to search for more

LAKs; or
l if the list is too long to read, enter a LAK name into the Search text box to

locate the LAK in the list.

After selecting a LAK, the PC tool connects to the wheelchair and displays its configuration
program.

5.3.2 Modify a program
To modify a program, first select a parameter and then edit it.

5.3.2.1 Select a parameter

Figure 50: Primary sidebar

Select a parameter from one of the parameter groups
(components) listed in the primary navigation sidebar‡1:

l Functions — for drive, seating and mouse mover functions
l User preferences — for drive, sleep, lock, user function

navigation and control input / output, display, energy use,
speedometer, and audible cues settings

l Modules — for modules (power modules, remote modules
etc.)

l Motions — for actuator motions
l Positions — for memory positions
l Angle Sources — for angle sources
l Trigger Angles — for trigger angles and rules
l Core features — for battery management, anti-rollaway,

actuators, firmware and system configuration
l Drive limits — for emergency deceleration and OEM limits
l Gyro limits — for OEM gyro limits

Lighting — for position and turn indicators
‡1 - not all parameter groups are available in Distributor view
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Note
Parameter groups displayed in the primary navigation sidebar depend on the modules in the connected system.
If the connected system does not include a module (for example, lighting or a gyro) it will not appear in the
sidebar. A secondary sidebar displays for certain parameter groups. It appears to the right of the primary
navigation sidebar to help you drill down further through the parameter lists.

5.3.2.2 Edit a parameter
Parameters can be modified in a number of ways:

l numerically (see 5.5.1.1 Numerical)
l by text (see 5.5.1.2 Text-based)
l from a drop box (see 5.5.1.3 Drop-down list)
l via a switch (see 5.5.1.4 Switch)

There are two edit modes:
l live edit (see 4.2.1 Live edit ) and
l bulk edit (see 4.2.2 Bulk edit ).

A live edit is written and applied to the wheelchair immediately as the edit is made. Bulk
edits are written to the wheelchair when the Write function is applied by the user.

Warning
In live edit, changes to parameters take immediate effect, changing the wheelchair's performance immediately.
There is no function to undo a change in live edit. Save a copy of the existing program before live editing to
enable you to restore settings if required.

5.3.3 Write a program to a wheelchair
In connection context and working in live edit, there is no need to write a program to a
wheelchair because all parameter changes are written to the wheelchair instantly.

In bulk edit, you write to the wheelchair by clicking the Write button in the tool bar.

Figure 51: Writing parameters—bulk edit

After clicking Write, the PC tool performs the following tasks:
1. Writes the program to the wheelchair.
2. Power cycles the wheelchair.
3. Reads the program from the wheelchair.
4. Reads diagnostic information from the wheelchair.
5. Reverts to live edit.

5.3.4 Read a program from a wheelchair
The configuration program is automatically read and displayed from a wheelchair system
when you connect to it in the connection context. To read a program in the file context:
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1. Click the "+" tab and select a file.
2. Click Read (from wheelchair) on the tool bar. The program is read from the

wheelchair to the file.

Figure 52: Reading a configuration from the file context

Note
If you click Read in connection context's bulk edit, the system returns you to live edit and any changes you made
are lost. In file context, click File | Save (or Save As) after reading the program if you wish to save it to the file.

5.3.5 Save a program as a file

To save the connected program as a file:
l Click the Save to file button on the toolbar; or
l Click File on the menu bar and select either Save or

Save As... from the menu.
For all options, a Save File As dialogue will open.

l Select an appropriate folder and enter a name into the
File Name text box.

l Click Save to finish — the file will be saved with a .lci
extension.

Figure 53: Save to file button

Figure 54: File menu

5.3.6 Authorise computer (store the Access Level Certificate)
To edit files offline, you need to authorise your computer by storing an Access Level
Certificate, taken from a connected LiNX Access Key, to your computer.

The certificate determines how you view and edit offline programs (*.lci files).

There are two supplied levels of access:
l Distributor
l Manufacturer

To edit your files with a distributor's access level, you need to store a certificate from a
distributor-level LiNX Access Key (DLX-HKEY01-A).

To edit your files with a manufacturer's access level, you need to store a certificate from a
manufacturer-level LiNX Access Key (DLX-HKEY02-A).

If you do not store your certificate from your LiNX Access Key, you will have read-only
access to your stored files, and will not be able to edit them.
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5.3.6.1 How to store the Access Level Certificate
To store the Access Level Certificate:

1. Connect to a LiNX system.
2. Click on the File menu.
3. Click Authorise Computer.

A message displays saying how many authorisations
remain and asks if you want to continue. (You can only
perform this operation ten times.)

4. Click the Authorise button to continue.
A message displays when the authorisation is complete.

5. Click OK to finish.

Figure 55: Authorise computer
file

Figure 56: Completing the authorisation

5.3.7 Manage chair configurations
5.3.7.1 Use the tool bar controls
To manage the chair configurations, use the Reset to
Default and Manage controls on the tool bar. Figure 57: Manage configurations

5.3.7.2 Set default chair configuration
1. Click Manage to open the chair

configuration list.
2. Select the configuration you require

from the list.
3. Select Load as Current.
4. Click Discard on the dialog that

appears.

The selected dialog becomes the
current and default configuration.
"Default Configuration" appears under
it.

Figure 58: Set default configuration
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5.3.7.3 Reset to default
To change the connected configuration to the default chair configuration:

1. Click Reset to Default on the tool bar.
A notification displays, with Discard and Cancel buttons, warning that the reset
process overwrites the existing configuration.

2. Click Discard to reset the default and overwrite the connected configuration.

Note
The default chair configuration means the last connected configuration.

If chair configurations are not supported, such as in LiNX LE systems, the Reset button will not be displayed.

5.3.8 Disconnect from a wheelchair
To disconnect from a connected wheelchair, click the Disconnect
wheelchair button on the right-hand side of the toolbar.

The system returns to the Connection Context screen.
Figure 59:

Disconnect wheelchair

5.3.9 Tune the gyro
Note

A gyro module must be connected and enabled in the current drive function before continuing. Gyro tuning is
available only in live edit. For more information on gyro tuning, refer to the LiNX Systems Installation Manual
(GBK54036).

1. From the menu bar, click on Calibrate | Gyro
2. Follow the instructions on the screen.

Figure 60: Tuning the gyro
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5.3.10 Tune adaptive load compensation (ALC)
Note

Adaptive load compensation (ALC) must be enabled before tuning. To enable ALC:
1. From the primary sidebar, click on Modules.
2. Click on Power Module in the secondary sidebar.
3. Scroll down the parameters to the section Power Module - Load Compensation, enable Bulk Edit, and

switch on Adaptive Load Comp Enabled.
4. Click on the Write to chair button.

To tune adaptive load compensation:
1. From the menu bar, click on Calibrate | Adaptive Load Compensation. The ALC

calibration screen is displayed.
2. Read the instructions and then click on OK.
3. Follow the instructions on the screen, as they are presented, to complete the

calibration.

Figure 61: ALC calibration screens: start (left), interim results (middle), and calibration completed (right)

5.3.11 Calibrate sip and puff
Note

An input module must be connected and Sip and Puff enabled in the module before calibrating. To enable Sip
and Puff:

1. From the primary sidebar, click on Modules.
2. Click on IN 500.
3. Click User Input Configuration, unlock Bulk Edit, and select Sip and Puff from the User Input

Configuration drop-down menu.
4. Click Write to chair button.

5.3.11.1 Open sip and puff calibration
1. From the menu bar, click on Calibrate | Sip and Puff. The sip and puff calibration

screen is displayed.
2. Calibrate sip and puff as required, using the sliders on the right of the screen to set

the levels as required for hard puff, soft puff, hard sip and soft sip.
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Figure 62: Sip and puff calibration — from left to right: hard puff, soft puff, hard sip, soft sip

Note
Refer to the LiNX System Installation Manual (GBK54036) for technical details on how to calibrate sip and puff.

5.3.12 Joystick shaping
1. From the menu bar, click on Calibrate | Joystick Shaping | [choose remote

module]. The calibration screen opens with an instruction explaining how to perform
the calibration.

Note
l Select Cancel at any time to exit the calibration screen without saving any changes.
l Select Restart at any time to reset the calibration screen and display the configuration’s existing values.
l Select Done when you are finished. This will exit the screen and save any values that have changed.

2. Ask the user to deflect the joystick in all four directions. The user can deflect the
joystick in any of the quadrants, in any order, but should be deflected to a point that
is comfortable and repeatable. Note that the + and - buttons next to the quadrant
parameters can be used to fine-tune the values.

3. Once the user has completed deflecting the joystick in each quadrant, tap on the
Done button to exit the calibration screen. At this point, the calibration values, as
indicated with the light blue bars and also shown numerically in the parameter
interface, will be saved to the configuration.
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Figure 63: Joystick shaping calibration screen

Note
Refer to the LiNX System Installation Manual (GBK54036) for technical details on joystick shaping.

5.3.13 Update memory positions
Memory positions can be updated using the LiNX Access PC tool. This is useful for
manufacturers when creating positions, and also distributors and therapists when working
with users to fine-tune or replace a memory position.

When updating a memory position, each Target Angle parameter related to the selected
position is updated with the current, corresponding angle source measurements from the
connected chair.

Note
Memory positions that only use switch feedback are not updateable. If a memory position uses a mix of switch
and angle feedback, actuators using angle feedback can be updated, but those using switch feedback will not be
updated. All memory positions that include angle feedback are updateable with Manufacturer access level. With
Distributor access level, memory positions that have been configured by the Manufacturer to have no Distributor
access and to not Allow Occupant to Update Position will not be updateable.

To update a memory position's target angles from its current angle settings:
1. reposition the chair's seating to the new target position using motions (such as

recline, tilt etc.)
2. from the LiNX Access PC tool, locate the position you wish to overwrite:

l click on Positions in the primary sidebar
l select the position that you wish to update from the secondary sidebar

3. click on the Update Position button at the top of the screen ( ) - all Target Angles
associated with this position will be updated according to the current angle source
measurements from the chair.
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5.4 File context tasks
The following tasks apply to the file context
— that is, when you are working on files
stored on your computer. (For connection
context tasks, see 5.3 Connection context
tasks.)

5.4.1 Open a file
You can choose to open a file:

l when opening the tool
l when the tool is open
l from the File menu

After selecting a file, the PC tool opens the file under its own tab — the tab displays the file
name.

5.4.1.1 When opening the tool
1. Open the LiNX Access PC tool application. (See 5.1 Open the LiNX Access PC tool.)
2. From the Open a file tab:

l select a file from the list; or
l press the Open file button (top left) to open the Open file dialogue; or
l if the list is too long to read, enter a LAK number in the Filter parameters text

box to locate the LAK in the list

5.4.1.2 When the tool is open
1. Click the new file tab (+) in the tab bar.
2. From this tab:

l select a file from the list, or
l press the Open file button (top left) to open the Open file dialogue, or
l enter a file name into the Filter parameters text box to locate the file from the

list

5.4.1.3 From the File menu
1. Click File | Open file (or Ctrl + O).
2. Find the file with the Open file dialogue.

5.4.2 Modify a file
To modify a program on a file, first select a parameter and then edit it.
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5.4.2.1 Select a parameter

Figure 64: Primary
navigation sidebar

Select a parameter from one of the parameter groups
(components) listed in the primary navigation sidebar‡1:

l Functions — for drive, seating and mouse mover functions
l User preferences — for drive, sleep, lock, user function

navigation and control input / output, display, energy use,
speedometer, and audible cues settings

l Modules — for modules (power modules, remote modules
etc.)

l Motions — for actuator motions
l Positions — for memory positions
l Angle Sources — for angle sources
l Trigger Angles — for trigger angles and rules
l Core features — for battery management, anti-rollaway,

actuators, firmware and system configuration
l Drive limits — for emergency deceleration and OEM limits
l Gyro limits — for OEM gyro limits
l Lighting — for position and turn indicators

‡1 - not all parameter groups are available in Distributor view

Note
A secondary sidebar is displayed for certain parameter groups. It appears to the right of the primary navigation
sidebar and helps you drill deeper through parameter lists.

5.4.2.2 Edit a parameter
Parameters can be modified in a number of ways:

l Numerically (see 5.5.1.1 Numerical)
l By editing text (see 5.5.1.2 Text-based)
l From a drop box (see 5.5.1.3 Drop-down list)
l Via a switch (see 5.5.1.4 Switch)

In file context, parameters can only be modified in bulk edit mode (see 4.2.2 Bulk edit ).
When you edit a parameter in bulk edit mode, its background colour changes to yellow. The
yellow background reverts to white when the file is saved or written to a wheelchair.

Figure 65: Bulk edit parameter change indication
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5.4.3 Save a file
Save a file with its existing name or with a different name.

5.4.3.1 Save a file with its existing file name
l Click the Save file button, Figure 66, (right-hand-side of the tool bar); or
l Click File on the menu bar and select Save from the drop-down menu, Figure 54.

Figure 66: Save file button

Figure 67: File menu

5.4.3.2 Save a file with a different name
l Click File | Save As... from the drop-down menu. A Save File As dialog opens.
l Select an appropriate folder.
l Enter a name into the File Name text box.
l Click the Save button to finish. The file is saved with a .lci extension.

5.4.4 Read a program from a wheelchair
To read a program from a wheelchair to a .lci file on your computer:

1. In the connection context, connect to a wheelchair.
2. Open a .lci file:

l Click File | Open File.
l Browse to the file you require.
l Click Open.

3. Click Read (top-left of screen) to read the program file from the wheelchair to the .lci
file.

Figure 68: Read from a wheelchair
4. Save the file.
Note

The Read and Write buttons are available only when a wheelchair is connected.
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5.4.5 Write a program to a wheelchair
Write a program from a file to a wheelchair by clicking the Write (to wheelchair) button
when connected to a wheelchair.
After you click Write, the PC tool:

l writes the program to the connected wheelchair
l power cycles the wheelchair
l reads the program from the wheelchair
l reads diagnostic information from the wheelchair

Figure 69: Write to a wheelchair

Note
The Read and Write buttons are available only when a wheelchair is connected.

Note
Oversized configurations cannot be written to the system. If the current configuration becomes too large to be
written to the system, a pop-up is displayed advising that unused items, such as profiles, functions, and rules,
should be removed to reduce its size. The LiNX Access tool checks for oversized configurations:

l before writing to a system
l on completion of editing functions and profiles
l after adding (duplicating) a function
l after deleting a function
l after adding/deleting a motion, position, trigger angle

or angle source
l after adding/deleting a module
l after a migration
l after loading a configuration

5.4.6 Close a file
Close a file using the Close file button on the right-hand side of the tool bar. If
you attempt to close a file with changes pending, a dialogue opens with
options to:

l Save — save the changes before closing
l Discard — discard the changes and close the file
l Cancel — cancel the file and close the action

Figure 70:
Close file

5.4.7 Remove a file from the file list
Right-click a file in the open file dialog and
select Remove from list.

Figure 71: Remove file from list
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5.5 Common tasks
This section describes tasks common to both the connection context and the file context.

5.5.1 Edit and modify parameters
There are several ways to edit and modify parameters:

l Numerically l Text-based
l Drop-down list l Switch

5.5.1.1 Numerical
There are three ways to numerically edit a parameter:

Click Min, Default or Max to set the parameter
value to one of the displayed values.

Figure 72: Editing a parameter numerically

Left-click the -/+ buttons to decrease or
increase the parameter's value respectively.
Clicking and holding the -/+ buttons changes the
value more quickly than single clicks.
Double-click the value and change it directly via
the keyboard — press the Enter button to set the
value.

5.5.1.2 Text-based
Click in a text box and use the computer keyboard
to edit and enter text.

Figure 73: Editing text

5.5.1.3 Drop-down list
Click the drop-down list to select an option.

Figure 74: Drop-down selection

5.5.1.4 Switch
Click the switch to change the parameter's
value.

The value displayed is the current value.

Figure 75: Switch selection
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5.5.2 Profile and function actions
In bulk edit:

l profiles can be added and deleted
l functions can be added, deleted, duplicated and moved

Select Functions in the primary navigation sidebar, and profile and function actions appear
in the toolbar.

Figure 76: Profile and function actions in the toolbar

The actions are:

Add a profile Add a function

Duplicate a function Delete a profile or function

5.5.2.1 Add a profile
1. Click the Add profile button.

A new profile appears with a red indicator next to it. The red indicator displays until
you add functions to the profile.

2. Add functions to the profile.
3. Press the Write button to write the program to the chair; or, on the Application menu,

save your changes to a file.

5.5.2.2 Delete a profile
Note

A profile cannot be deleted until its functions are deleted.

1. Delete all the functions in the profile to be deleted.
2. Select the profile.
3. Click the Delete button.
4. Click the Write button to write the program to the chair or, on the Application menu,

save your changes to a file.
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5.5.2.3 Add a function
To add a new function:

1. Click the Add function button.
2. Select a function from the drop-down list:
l New Drive Function
l New Seating Function
l New Mouse Mover Function
l New Utility Function
l New Switch Control Function

Figure 77: Add a function

If New Drive Function is selected in step 2 above, the next steps are detailed in 5.5.2.3.1
New drive function.

If New Seating Function, New Mouse Mover Function or New Utility Function is
selected in step 2 above, the next steps are detailed in 5.5.2.3.2 New seating, mouse
mover, utility or switch control function.

5.5.2.3.1 New drive function
When adding a drive function from step 2 above, the New Drive Function dialog
box appears. In this dialog box, you have a choice to add the new drive function
with default values or add it with values from a template.

Drive function based on default values
1. Enter a function name.
2. Select the New Function tab
3. Select a user input from the User

Input list.
4. Click Create.
5. Click the Write button to write the

program to the chair; or, on the
Application menu, save your changes
to a file.

Figure 78: New drive function from
default values

GBK54033 LiNX Access PC
User Manual Issue 12

How to... - Page 53



GBK54033 LiNX Access PC
User Manual Issue 12

Drive function from template
1. Enter a function name.
2. Select the From Template tab
3. Select a template from the template

list.
4. Click Create.
5. Click the Write button to write the

program to the chair; or, on the
Application menu, save your changes
to a file.

Figure 79: New drive function from
template

5.5.2.3.2 New seating, mouse mover, utility or switch control function
For seating, mouse mover and
utility functions, in the dialog
box that appears:

1. Enter a function name.
2. Select a user input from

the user input list.
3. Click Create.
4. Click the Write button to

write the program to the
chair; or, on the
Application menu, save
your changes to a file.

Figure 80: New function details
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5.5.2.4 Duplicate a function
Note

A duplicated function has the same name as the original function. Give the duplicated function a unique name.

1. Select the function you
wish to duplicate.

2. Click the Duplicate
function button.
The duplicated function
appears directly under
the original function.

3. Edit the duplicated
function as required.

Figure 81: Duplicate a function

Note
The duplicated function's parameters appear highlighted in yellow until the program is written or saved.

5.5.2.5 Delete a function
1. Select the function you

wish to delete.
2. Click the Delete button.

Warning
A function is deleted immediately
when you click the delete button.

Figure 82: Delete a function
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5.5.2.6 Move a function
Functions can be reordered by dragging and dropping inside a profile or between profiles.

1. Click and hold the
function you wish to
move.
The function moves
slightly up and to the
right and a dashed box
appears beneath it.

2. Drag the function to the
required position in the
profile, or to another
profile.

Figure 83: Reorder functions

5.5.3 Add and remove components
A number of components, such as modules, motions, positions, etc., can be added or
removed as required. All components can be added from the Edit menu item. Also, if a
component family is selected from the primary navigation sidebar, components can be
added or removed using the add/remove icons above the secondary navigation bar. These
are detailed next.

5.5.3.1 Add and remove a module

Add a module from the Edit menu
From the menu bar, click on Edit | Add Module — a
pop-up window will open with a list of modules. Select
a module from this list and click on the Create button
to add it to your configuration.

Figure 84: Edit - add module

Add a module from the secondary navigation sidebar
Click on Modules in the primary navigation sidebar and then
click on the Add Modules button (Figure 85) that is located
at the top of the secondary navigation sidebar. Figure 85: Add Module

button
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Remove a module from the secondary navigation sidebar
Click on Modules in the primary navigation sidebar. Select a
module from the secondary navigation sidebar to remove.
Click on the Remove button (Figure 86) that is located at
the top of the secondary navigation sidebar.

Figure 86: Remove
module button

5.5.3.2 Add and remove a motion

Add a motion from the Edit menu
From the menu bar, click on Edit | Add Motion.

Click on Motions in the primary navigation sidebar to
view the new motion in the secondary navigation
sidebar.

Figure 87: Edit - add motion

Add a motion from the secondary navigation sidebar
Click on Motions in the primary navigation sidebar and
then click on the Add Motion button (Figure 88) that is
located at the top of the secondary navigation sidebar. Figure 88: Add motion

button

Remove a motion from the secondary navigation sidebar
Click on Motions in the primary navigation sidebar. Select
a motion from the secondary navigation sidebar to
remove. Click on the Remove button (Figure 89) that is
located at the top of the secondary navigation sidebar.

Figure 89: Remove
motion button

5.5.3.3 Add and remove a position

Add a position from the Edit menu
From the menu bar, click on Edit | Add Position.

Click on Positions in the primary navigation sidebar to
view the new position in the secondary navigation
sidebar.

Figure 90: Edit - add position

Add a position from the secondary navigation sidebar
Click on Positions in the primary navigation sidebar and
then click on the Add Position button (Figure 91) that is
located at the top of the secondary navigation sidebar. Figure 91: Add position

button
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Remove a position from the secondary navigation sidebar
Click on Positions in the primary navigation sidebar. Select
a position from the secondary navigation sidebar to
remove. Click on the Remove button (Figure 92) that is
located at the top of the secondary navigation sidebar.

Figure 92: Remove
position button

See also
See "Update memory positions" on page 46

5.5.3.4 Add and remove an angle source

Add an angle source from the Edit menu
From the menu bar, click on Edit | Add Angle Source.

Click on Angle Sources in the primary navigation
sidebar to view the new angle source in the secondary
navigation sidebar.

Figure 93: Edit - add angle
source

Add an angle source from the secondary navigation sidebar
Click on Angle Sources in the primary navigation sidebar
and then click on the Add Angle Source button (Figure
94) that is located at the top of the secondary navigation
sidebar.

Figure 94: Add angle
source button

Remove an angle source from the secondary navigation sidebar
Click on Angle Sources in the primary navigation sidebar.
Select an angle source from the secondary navigation
sidebar to remove. Click on the Remove button (Figure 95)
that is located at the top of the secondary navigation
sidebar.

Figure 95: Remove
angle source button

5.5.3.5 Add and remove a trigger angle

Add a trigger angle from the Edit menu
From the menu bar, click on Edit | Add Trigger Angle.

Click on Trigger Angles in the primary navigation
sidebar to view the new trigger angle in the secondary
navigation sidebar.

Figure 96: Edit - add trigger
angle

Page 58 - How to...



Add a trigger angle from the secondary navigation sidebar
Click on Trigger Angles in the primary navigation sidebar
and then click on the Add Trigger Angle button (Figure
97) that is located at the top of the secondary navigation
sidebar.

Figure 97: Add trigger
angle button

Remove a trigger angle from the secondary navigation sidebar
Click on Trigger Angles in the primary navigation sidebar.
Select a trigger angle from the secondary navigation
sidebar to remove. Click on the Remove button (Figure 95)
that is located at the top of the secondary navigation
sidebar.

Figure 98: Remove
trigger angle button

5.5.4 Change the system and program name
The system and program names are located in the top-right of the Home view and can be
edited directly there.

Figure 99: System and program name

To change the system and program names:
1. Click Home on the primary navigation sidebar.
2. Click in the System Name or Program Name text box and edit the name.
3. Save your changes:

l When working in connection context's live edit mode or bulk edit mode: click
Write to write your changes to the wheelchair.

l When working in file context: click File | Save to save your changes to the file.

Note
The system name cannot be changed with a distributor-level LiNX Access Key.
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5.5.5 View system information
Click Home in the primary
navigation sidebar to display an
overview of the connected
system.

Figure 100: Viewing system information

The Home screen displays the following information:
Driving / battery information Time statistics for driving and battery use

Events An overview of events

File information Time stamps for when the configuration was created
and last modified

System and program name The system and program names. These are editable.
(See Change the system and program name.)

Configuration summary Overview of modules, features and functions on the
connected system

System summary Click to view version information about the modules
in the connected system. (See View the system
summary.)

LiNX Access information LAK and application details
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5.5.6 View the system summary
The system summary displays version information about the modules in the connected
system.

To view, click the System Summary button
(see item 6 in Figure 100) at the lower-right
of the home screen.

The system summary displays each module
with its firmware status:

l A green marker indicates the firmware
is up-to-date

l A white arrow on a blue background
indicates the firmware is out-of-date
and an upgrade is available

Note
To upgrade the firmware, see 5.8.5 Upgrade firmware Figure 101: Viewing system summary

5.5.7 View the error and event logs
To view the wheelchair's event log, select Chair Log from the primary navigation sidebar.
The event log is displayed on the left-hand-side of the main content area. It shows active
and historical errors (from today and the past week).

Active errors display at the top of the log. The active errors screen displays faults that:
l are current on the connected LiNX system
l if in file context, were current when the file was read from the wheelchair

For all errors, the following information is recorded:
l event name – describes the active error
l module – displays the location of the error
l event code – displays the flash code
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System events are shown below the active
errors. For all events, the following
information is recorded:

l event name – describes the event
l module – displays the event location
l event code – displays an event code, if

any (For errors, this will be the flash
code)

l time stamp – date and time event
occurred (Not available on LiNX LE
systems)

To view more information about an event in
the chair log, click the event and its
description displays.

Figure 102: Section of the event log panel

Use Filter events to display events based on filter terms you enter.

Clear the filter, in the connection context: click the X on its right. Clear the event log, in the
connection context: click Reset Log.

Figure 103: Reset log

5.5.8 View statistics
The LiNX system records statistics for
battery use and driving.

To view the wheelchair's statistics, select
Chair Log from the primary navigation
sidebar.

The statistics display on the right-hand side
of the main content area, showing battery
and drive statistics.

Battery usage displays at the top of the
panel. Drive statistics display below the
battery statistics. Battery statistics are
detailed in the following table.

Figure 104: Section of the statistics panel
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Battery usage statistics Details
Battery Charging Time The length of time the batteries have been charged for
Number of Charge Cycles The number of times the batteries have been charged
Band 1 Indicator Time The total time the LiNX system is operated with the state of

charge between 0 and 20%
Band 2 Indicator Time The total time the LiNX system is operated with the state of

charge between 20% and 40%
Band 3 Indicator Time The total time the LiNX system is operated with the state of

charge between 40% and 60%
Band 4 Indicator Time The total time the LiNX system is operated with the state of

charge between 60% and 80%
Band 5 Indicator Time The total time the LiNX system is operated with the state of

charge between 80% and 100%
Average Battery Voltage The average battery voltage over the last 31 days
Last Charge Timestamp The date and time the batteries were last put on charge
Number of High Battery Events The number of high battery warnings
Number of Low Battery Events The number of low battery warnings
Number of Deep Discharge
Warnings

The number of deep discharge warnings

To view more information about a battery statistic:
click a statistic, and a description displays. To
reset the battery statistics' values: click Reset,
when in the connection context, at the top of the
battery statistics.

Figure 105: Reset battery statistics in connection
context

Note
Resetting the battery statistics resets the enhanced battery gauge algorithm. If your system uses the enhanced
battery gauge: after resetting the battery statistics, we recommend placing the wheelchair's batteries on charge
for a complete charging cycle so the enhanced battery gauge can display an accurate state of charge.

Drive statistics are shown below the battery statistics. (Use the scroll bar to access them.)

Drive statistic Details
Average Motor Current The average current drawn across all motors while driving
Maximum Left Motor Current The peak measured motor current
Maximum Left Motor Current Time Time spent drawing the "Maximum Drive Current Draw"
Maximum Right Motor Current The peak measured motor current
Maximum Right Motor Current
Time

Time spent drawing the "Maximum Drive Current Draw"

Powered Up Time The total time the wheelchair controller is powered up
Drive Time The total time the wheelchair has been driven
Average Daily Drive time Average drive time over a 24 hour period, and averaged over

previous 24 hour periods
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Drive statistic Details
Time Near Maximum Current The duration the current was within 20% of maximum threshold
Trip Distance The total distance travelled by this wheelchair in meters since

being reset by the user.
Total Distance Travelled The total distance travelled by this wheelchair since being reset

by a service agent.

To view more information about a drive statistic:
click a statistic, and a description displays. To
reset the drive statistics' values: click Reset,
when in the connection context, at the top of the
drive statistics.

Figure 106:  Reset drive statistics

5.5.9 Searching
Use the Filter parameters tool (at the bottom of the primary navigation sidebar) to locate a
parameter quickly.

To find a parameter:
1. Enter a term in the Filter parameters box.

Any parameter group containing the term is
highlighted in the primary navigation sidebar.

2. Select a highlighted group.

Figure 107: Search/filter tool

Any parameter containing the filter term is displayed in the main content area.

To clear the Filter parameters box and any displayed filtered items, click the X on the right
of the box. The box empties and the main content area reverts to its previous state.

5.6 Configure control inputs and outputs (control IO)
On selected LiNX modules, you can configure a control input (CI) to select and control an
output (CO) such as another LiNX module, function or feature.

An input, for example, can be an external buddy button connected to a control input pin on
a power module, a multi-way switch connected to a CI pin on an input module, or one of
the rocker buttons on a remote module. Outputs include seating, lighting, horns, and
function selection.

Control IO can be configured with unconditional or conditional rules. An unconditional rule
(or always rule) is applied to an output when you want to ensure that the output is
activated whenever its input is triggered.

A conditional rule (using if and if/else) is applied to control IO where you want the
activation of an output to be subject to the state or function of the system at the time the
input is triggered. That is, instead of an output always activating when its input is triggered
(like the always rule), it will activate only if the condition is true.
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Note
For more detailed descriptions about conditional control IO, including worked examples, see the LiNX System
Installation Manual (GBK54036).

This section describes how to set up control IO for your system:
1. Select and configure an input
2. Configure an always rule
3. Configure a conditional rule
4. Configure advanced settings

5.6.1 Select and configure an input
1. From the primary navigation sidebar Figure 108 , click on Modules.

Figure 108: Selecting and configuring control IO inputs

2. From the secondary navigation sidebar Figure 108 , labelled Modules, select the
module that your input is connected to. For example, if you have a buddy button
connected to one of the CI pins on the power module, select Power Module. If you
want to use one of the multi-function buttons on the REM400, select REM4xx.

3. Scroll down until you find the Port Settings Figure 108 for the control input that
you want to configure. For example, if you want to add a power button to the left jack
socket on a REM400, scroll down until you find Left Jack Socket (J1) Tip - Port
Settings.
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4. Under Port Settings, click on Input Type Figure 108 to reveal which input types
are available for the input. These differ depending on the module and your LiNX
Access Key access level (OEM/dealer). Input types available will be one or more of
the following:

l Not Connected
l 10-Way Switch
l Resistor Bands
l Button
l Power Button
l Function Key

5. Click on one of the Input Types Figure 108 to reveal its control IO slots:
l If you select 10-Way Switch, ten slots named Switch 1 through to Switch 10

are displayed.
l If you select Resistor Bands, ten slots named Band 1 through to Band 10 are

displayed.
l If you select Button, four slots (button types) are displayed: Momentary, Short

Press, Long Press and On Press.
l If you select Power Button or Function Key, no slots are displayed and there

is no further action required.

Note
Complex configurations, which have been pre-configured for the manufacturer, are not configurable through
the tool. For these slots:

o if the slot can be defined in a simple way, the slot will display the configuration summary and show this

icon: .

o if the slot cannot display the configuration summary, because of its complexity, it will display 'Restricted'

and the slot will show this icon: .

An example control IO slot, when opened, is shown in Figure 109. To open a slot, hover
your mouse pointer over it and click on the add rule button when it appears on the right-
hand side of the slot.

Figure 109: Example control IO slot

When creating a rule, the slot background is blue. The slot comprises a single drop-down
menu to select conditions (default is Always, meaning no conditions), and one or more
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drop-down menus to select output actions. On the right-hand side of the slot are the
commit rule and discard rule buttons. Click on the commit rule button when you have
finished creating this rule to tell the system to use this rule. Once committed, the slot's
blue background is removed. If you no longer want this rule, click on the discard rule button
to delete it.

Note
Each time you select a condition or output action in the control IO slot, it is saved automatically for you.
However, the rule will not be used in the system until you click on the Commit rule button.

5.6.2 Configure an always rule
To configure an always rule, you need to configure an output from the list of output actions
in the control IO slot.

1. Hover your mouse pointer over a control IO slot and click on the add rule button

when it appears on the right-hand side of the slot Figure 110 . Make sure the
conditions dropdown menu is set to Always.

Figure 110: Configuring an always rule

2. Click on the first output action drop-down menu, which is on the left-hand side,

under the conditions dropdown menu, and select an output action Figure 110 .
3. Click on the second and third output action drop-down menus (if available) to refine

the output action Figure 110 .
4. Click on the Commit rule button (check mark) to commit the rule Figure 110 .

To add more Always rules, repeat steps 1–4 above — note that each rule must be
committed (using the Commit rule button) before another rule can be added.

5.6.3 Configure a conditional rule
Conditions are selected from the conditions list. To assign a condition to your rule:

1. Hover your mouse pointer over a control IO slot and click on the add rule button

when it appears on the right-hand side of the slot Figure 111 .
2. From the conditions drop-down menu, select a condition Figure 111 .
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Figure 111: Configuring a conditional rule

3. From the first output action drop-down menu, which is on the left-hand side, under

the conditions dropdown menu, select an output action Figure 111 .
4. Click on the second and third output action drop-down menus (if available) to refine

the output action Figure 111 .
5. Click on the Commit rule button (check mark) to commit the rule Figure 111 .

To add more Conditional rules, repeat steps 1–5 above — note that each rule must be
committed (using the Commit rule button) before another rule can be added.

5.6.4 Configure advanced settings
The advanced settings allow you to (optionally) configure the control inputs further. Click
on the Advanced button (Figure 112) to reveal the following options:

l Stop Driving and Seating
l Input Port Debounce
l Enable Input
l Monitored
l Stability Checking
l Normally Closed

Figure 112: Advanced settings

The use of these is described below:

Stop Driving and Seating

This option ensures any activation of this control input will cause driving and
seating operations to stop. Select On or Off.
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Input Port Debounce

This option sets the time the signal on the input port has to be stable for,
before the system responds to the input. Set the Input Port Debounce time by
clicking on the + and - buttons. If it is set to zero seconds, no debounce is
applied.

Note
When Input Port Debounce is set to any value greater than zero, the following button inputs
cannot be configured: short press, long press, on press.

Enable Input

This option sets whether the input is enabled. Select On or Off.

Monitored

This option sets whether this input is monitored for electrical faults. Select On
or Off.

Stability Checking

This option sets whether this input is monitored for signal stability. Select On or
Off.

Normally Closed

This option sets whether the switch is normally-open or normally-closed.
Select On or Off.

See also
For more detailed descriptions about the advanced settings, and worked examples using these
steps, see the LiNX System Installation Manual (GBK54036).
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5.7 Configure memory positions
The following is an abridged, and more generic version of the LiNX Application Note Memory
Positions - Installation and Configuration. Its intention is to help you locate the parameters
you will need to set up an angle sensor-based memory position using the LiNX Access PC
tool.

5.7.1 Overview

Figure 113: Setting up a memory position in four steps

Figure 113 shows the four steps to
install and configure a LiNX system
with memory positions. It starts
with installing the necessary
modules (1), creating the servos
(2), and then creating a memory
position (3). After creating the
memory position, you then have a
choice on how to operate it: you can
either set up a control input (4a),
for example, a buddy button, or set
up a seating function (4b) to
operate it from a remote module.

5.7.2 Step 1 - Install modules
Install and connect the required actuators, actuator modules, and angle sensors to the
wheelchair and then edit the port settings and angle sources.

5.7.2.1 Port settings
For each control input angle sensor1 in your system, specify the port that it is wired to. The
Port Settings (Figure 114) are found under Modules | [module] | CONTROL INPUT [n] -
PORT SETTINGS (where [module] is a connected module such as the power module or
actuator module, and [n] is the control input number). For example, if the angle sensor is
connected to control input 1 on the power module, select Modules | Power Module |
CONTROL INPUT 1 - PORT SETTINGS.

l Change Input Type to Control Input Angle Sensor.
l Edit Zero Point Offset, if applicable (depends on your installation)
l Edit Clockwise Rotation, if applicable (depends on your installation)

1You do not have to do this for actuator module angle sensors — the actuator module connects to the LiNX system via the
LiNX bus and its angle sensor is recognised on power-up.
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Figure 114: Specify the port to which the control input angle sensor is wired

5.7.2.2 Angle sources
Identify and map each angle sensor that has been installed to specific, named angles called
"Angle Sources". Select Angle Sources from the primary navigation bar and then select an
unused angle source from the secondary navigation bar (Figure 115) — the default name for
these sources is Angle Source 1, Angle Source 2, etc.

Note
If Angle Sources is not available in the primary sidebar, you can add it by selecting the Edit menu at the top of
the screen and then clicking on Add Angle Source.

l Click on Angle Source Name and rename the source to something more appropriate
and memorable ('Backrest', for example, if the source measures the angle of the
backrest).

l Click on the Angle Sensor drop-down box and select which angle sensor you will be
using for this angle source.

l If you intend to use a relative angle for position control, select a second angle sensor
from the Reference Angle Sensor drop-down box.

Figure 115: Select an Angle Source

5.7.3 Step 2 - Create servos
Create one or more servos by linking the angle sources to the actuator channels.

Locate the actuator channel settings for the module you are using under Modules |
[module] | ACTUATOR CHANNEL [n] - SETTINGS (where [module] is a power module or
actuator module, and [n] is the actuator channel number). For example, if you are using
actuator channel 1 on the ACT200-1 module, the settings parameters can be found under
Modules | ACT200-1 | ACTUATOR CHANNEL 1 - SETTINGS.

Figure 116: Create servos
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l Select the type of position control for this actuator channel from the Type of Position
Control drop-down box.

l Select the angle source that will be associated with this actuator from the Angle
Source for Position Control drop-down box — the names in the drop-down box are
derived from the Angle Sources you created in step 1.

l With Direction to Increase Angle, select the direction this actuator will move in
order to increase the angle during position control. Set to Extend if the angle of the
angle source increases when the actuator extends; set to Retract if the angle of the
angle source increases when the actuator retracts. To help you with this, use Live
Diagnostics in the LiNX Access iOS tool to monitor the angle readings while operating
the actuator.

5.7.4 Step 3 - Create memory position
Name and define a memory position using its identification and actuator parameters.

From the primary sidebar, click on Positions and select an unused position from the
secondary sidebar — Figure 117. If you need to add a new one, click on the Add Position

button — a new position will be added.

Figure 117: Configuring a Position

Note
If Positions is not available in the primary sidebar, you can add it by selecting the Edit menu at the top of the
screen and then clicking on Add Position.

Under the identification section, edit the following parameters:
l Position Name
l Position Icon
l Angle Source to Display (useful for display remote modules only)

Page 72 - How to...



Under the channel section, edit the following parameters:
l Sequence Order1

l Target Angle2

You may also consider editing the following parameters under the configuration section:
l Soft Start Time
l Direct Access Position Speed
l Distributor Access
l Allow Occupants to Update Position

5.7.5 Step 4a - Configure a control input
Set up a control input to activate a memory position.

Follow the steps below to specify which port the control input (button/switch) is connected
to, and then set its behaviour — that is, for example: when pressed momentarily by the
user, activate and latch the named memory position:

1. From the LiNX Access tool, go to Modules | [module] | CONTROL INPUT [n] - PORT
SETTINGS (where [module] is a power module or actuator module, and [n] is the
control input number) — see Figure 118.

Figure 118: Configure a control input

2. Under Port Settings, click on Input Type and select Button or 10-Way Switch —
this will reveal its control IO slots: Momentary, Short Press, Long Press, and On Press.

3. Select "add rule" when hovering over your chosen control IO slot.
4. Leave the first drop-down box as Always.
5. From the second drop-down box, select Seating.
6. From the third drop-down box, select the name of the Position, for example: P1

Position 1.
7. From the fourth drop-down box, select Latched.
8. Click on the tick button (white tick, green background) to save this input.

1The Sequence Order determines at which point, if at all, the actuator channel powers during the operation of this memory
position. Any channel whose Sequence Order is set to zero is not used in the memory position operation. If different values
are used (except zero), the actuator channels drive in order, one after the other, starting with the lowest number - that is, 1
first, 2 second, etc. If the same value is used across channels, they power at the same time.
2The Target Angle is set between -180° and +180° with a resolution of 1°. When an actuator drives as part of this memory
position, it stops when it reaches the target angle.
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Your memory position is now ready to be used. Test its operation with the control input
created above.

5.7.6 Step 4b - Configure seating function
Set up a seating function to activate a memory position.

Follow the steps below to create a new seating function and then configure a quadrant to
activate the memory position.

5.7.6.1 Create function
1. Click on the Functions menu item in the primary sidebar — Figure 119-1.
2. Click on a profile — Figure 119-2.
3. Click on the New Function button — Figure 119-3.

4. Click on the New Seating Function button — Figure 119-4. The New Seating
Function window is displayed (Figure 120).

Figure 119: Creating a new seating function Figure 120: New Seating Function details

In the New Seating Function window:
5. Add the name of the memory position — Figure 120-5
6. Select a remote module — Figure 120-6.
7. Click on the Create button — Figure 120-7.

5.7.6.2 Configure quadrant
Set Input Mode (under the General settings, Figure 121) to Four Quadrant — memory
positions cannot be used when Input Mode is set to either Forward/Reverse or Left/Right.

Select a quadrant that will activate the memory position (for example, forward quadrant),
and set its parameters as follows:

l click on the Motion/Position drop-down box and select the position;
l click on the Operating Mode drop-down box and select Latched;
l set the Speed.

Your memory position is now ready to be used. Test its operation with the seating function
created above.
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Figure 121: Seating functions - configuring a quadrant for position activation

See also
See "Update memory positions" on page 46
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5.8 Tool utilities

5.8.1 Configure Internet settings
If your computer accesses the Internet via a proxy server, you will need to configure your
Internet settings.

To do this:
1. Click Help > Internet Settings.
2. Select the Proxy Enabled switch.
3. Add the following details‡1:

l Proxy address and port
l User name
l Password

4. Click Close.

Figure 122: Setting up the proxy settings

Note
#1 — You may need to consult your IT department for this information.

5.8.2 Set friendly name
The LiNX Access Key is normally identified with the letters 'LAK' followed by a series of
characters – for example: LAK-L12147605. Each name is unique, but identifying one key
from another may become difficult when there are several names.

You can change the names to friendly names using the Set Friendly Name feature:
1. Open a Connection tab. You may have to close your connection if you are already in

the connection context.
2. Select Set Friendly Name from the

menu.

Figure 123: Set friendly name

3. Enter a new name into the Friendly
Name text box.

Figure 124: Entering the friendly name

4. Click OK. After clicking OK:
l the wheelchair power-cycles
l the friendly name updates
l the confirmation screen displays
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5.8.3 Forget device
To remove a LiNX Access Key
from the context selection
screen, right-click the key and
select Forget Device from the
menu.

It will then not appear in the
connection list. Figure 125: Forget device

Use the Find more option at the top-left of the connection screen to search for and re-
display the key in the list.

5.8.4 Check for new version
The PC tool automatically‡1 checks for updated software (for the PC tool) and firmware.
This operation requires an Internet connection. It is only performed once in a 24 hour
period.

If application updates are available, a notification displays asking if you want to download
them‡2.

l Click Yes to continue.

After downloading, a notification displays asking if you want to install the updates‡2.
l Click Yes to continue.

Figure 126: Download updates Figure 127: Install updates

Note
‡1—To manually check for updates, click on the main menu: Help | Check for update. (An Internet connection is
required.)
‡2—Only new versions of the application software require a download confirmation. If new firmware is available,
it will be downloaded at the same time as the application software, but it will not be installed. Installation of
firmware is a manual operation that lets you choose when to upgrade each module.
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If new firmware is available, a notification displays.

l Click View Updates to view the firmware
modules that need updating and to select the
modules you wish to update.

See Upgrade firmware for information on how to
upgrade the firmware. Figure 128: Incompatible LAK

5.8.5 Upgrade firmware
Warning

Before upgrading firmware, ensure the battery level is not low, and the wheelchair is in a safe and stable state –
for example, place it on blocks to elevate it from the ground.

DO NOT upgrade firmware when the wheelchair is on a slope, or when the park brakes are disengaged.

To access the module firmware upgrade screen:
1. Ensure the system is in connection context.
2. Click the Home menu item in the navigation sidebar.
3. Click the System Summary button.

The system summary displays each
module with its firmware status:

l A white arrow on a blue background
indicates the firmware is out-of-
date and an upgrade is available

Firmware can be upgraded on modules
individually or all at once.

To upgrade individually:
l Select a single module and click the

Update button.

To update all at once:
l Click Update All.

Figure 129: Firmware status in System Summary

See also
5.9 Manage configurations and firmware with bundle files
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5.8.6 View as manufacturer or distributor
Manufacturers and distributors have different access levels when using the LiNX Access PC
tool:

l Manufacturers have access to all parameters
l Distributors have access to a limited number of the parameters

For a manufacturer to understand the distributor's view of these parameters, the
manufacturer can change the PC tool's display to show distributor parameters only.

This is useful when, for example, a manufacturer remotely (including by telephone or email)
helps a distributor configure a wheelchair and needs to see the wheelchair's parameters
from a distributor's perspective.

To change views, click View from the Menu
bar and select from:

l View as Manufacturer
l View as Distributor

Figure 130: Selecting the view

Note
These menu items are available only to manufacturers.

Figure 131: View as manufacturer Figure 132: View as distributor
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5.9 Manage configurations and firmware with bundle files
To help manage and distribute LiNX configurations and firmware upgrades, the
manufacturer can use a bundle file. A bundle file is a collection of files that can be used to
program a system either at the time of manufacture, or in the field. For instance, the bundle
file can be used to:

l program a LiNX system at the time of manufacture — this ensures all chairs are
programmed with the same configuration and firmware;

l rescue a system in the field to get it back to a default / known state;
l update systems in the field after a manufacturer's configuration update.

5.9.1 Creating a bundle file
A bundle file is created by the manufacturer, and can include one or more of the following:

l chair configurations (these have the file extension .lci);
l firmware upgrades (these have the file extension .lfiz).

Once created, the bundle file will have the extension .lcb.

To create a bundle file, click on File | Create Bundle File (Figure 133) from the main menu
— the Create Bundle File dialogue opens (Figure 134). Firmware that you choose to be
included in the bundle file will be displayed in the top half of the dialogue, and
configurations that you choose to be included in the bundle file will be displayed in the
lower half of the dialogue. To continue, follow the three steps below.

Figure 133: Create Bundle File
menu

Figure 134: Create Bundle File dialogue

STEP 1: Add firmware files (optional)
To add firmware files to your bundle file, you can either select files specific to a market
release (MR) or select them manually using a file explorer.

Select files specific to a market release
Click on the dropdown box, located top and middle of the dialogue, and select
one of the MR items (Figure 134). The firmware field in the dialogue will be
populated with the relevant firmware files associated with your chosen MR.
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Note, when choosing to select firmware this way, the browse button (top, right
of the dialogue) will no longer be available.

Select files manually
Click on the browse button on the right-hand side of the dialogue to add files
manually. An Open File dialogue opens, where you can locate and select a
firmware file (*.lfiz). The selected file is added to the firmware field in the
dialogue. Repeat to add further firmware files.

Note
If, after adding a file, you wish to remove it, right-click
on the file and select Remove from the context menu —
it will be removed immediately (Figure 135).

Figure 135: Removing firmware files

STEP 2: Add configuration files (optional)
To add configuration files (maximum 8) to your bundle file, click on the add button that is
located on the right-hand side of the Select Configurations title bar (Figure 134). An Open
File dialogue opens, where you can locate and select a configuration file (*.lci). The
selected file is added to the next available configuration slot. Repeat to add further
configurations.

Note
Right-click on any configuration and select either
Replace or Remove from the context menu if you
would like to replace or remove the configuration from
the slot (Figure 136). If Replace is chosen, you will be
able to select a replacement configuration. If Remove
is chosen, the configuration is removed from the slot
immediately.

Figure 136: Replacing and removing configurations

STEP 3: Create the bundle file
To create the bundle file, click on the Create button at the base of the dialogue (Figure 137)
— a Save File As dialogue opens from which you can locate a suitable folder to save the file
to. Note that the file (which will be saved with a .lcb extension) is automatically given the
name of the first configuration file that was selected in step 2, above. If this name is
inappropriate, you can rename it. Click the Save button to finish.
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Figure 137: Create and save bundle file

When the bundle file is created and saved, a Success
pop-up is displayed — click on Ok to continue.

Figure 138: Success message

5.9.2 Distributing a bundle file
Once a bundle file has been created, it can be used by the manufacturer or distributed to a
customer for use in the field. When distributing the file, the file can be sent by email or via
media such as thumb drives, CD/DVDs etc.

Note
A bundle file is a binary file that can only be read by the LiNX Access tools. This is useful from a security point of
view when distributing the bundle file to, for example, a distributor, since the files cannot be altered by the
recipient.

5.9.3 Viewing the contents of a bundle file
To view the contents of an existing bundle file:

1. From the main menu, click on File | Open Bundle File (Figure 139) — an Open file
dialogue opens.

2. Locate your bundle file (*.lcb) in the Open file dialogue and then click on Open to
continue.

3. View the files presented in the bundle file dialogue (Figure 140).
4. Click on the Close button when you have finished viewing the files.
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Figure 139: Open Bundle File menu Figure 140: Writing the bundle file to the connected system

5.9.4 Programming from a bundle file
To program a system from a bundle file:

1. Connect to a LiNX system.
2. From the main menu, click on File | Open Bundle File

(Figure 141) — an Open file dialogue opens.
3. Locate your bundle file (*.lcb) in the Open file dialogue and

then click on Open to continue.
4. Review the files presented in the bundle file dialogue (Figure

142) and then click on the Write to Chair button. The bundle
file will be written to the connected system, during which the
write progress is displayed (Figure 143).

Figure 141: Open Bundle File
menu

Figure 142: Writing the bundle file to the connected system

Figure 143: Write progress

GBK54033 LiNX Access PC
User Manual Issue 12

How to... - Page 83



GBK54033 LiNX Access PC
User Manual Issue 12

Page 84
Page left blank intentionally



6 Index

1

10-Way Switch 66

A

About 25
Access Level Certificate 41-42
Active Errors 61
Actuator 39

ACT200 71
Actuator Motions 39, 48
Adaptive Load Comp Enabled 44
Adaptive Load Compensation 24, 31-32,

44
Add Angle Source 24
Add Function 53
Add Module 24
Add Motion 24
Add Position 24
Add Profile 52
Add Rule 67
Add Trigger Angle 24
ALC 31-32
ALC (Adaptive Load Compensation) 44
Always Rules 64
Angle Sensor 70
Angle Sources 39, 48
Anti-Rollaway 39
Audible Cues 39
Authorise Computer 24, 41-42
Average Battery Voltage 63
Average Drive Time 63
Average Motor Current 63

B

Band 66
Band 1 Indicator Time 63
Band 2 Indicator Time 63
Band 3 Indicator Time 63
Band 4 Indicator Time 63
Band 5 Indicator Time 63
Battery 12, 39, 63

Charging 63
Management 39

Usage 60
Battery Charging Time 63
Battery Gauge 63
Battery Usage 62
Bluetooth 18
Buddy Button 64
Bulk Edit 20, 22, 26, 40

parameter change indication 22
Bundle File 24

Create 24
Open 24

Button 18, 21, 37, 66

C

Calibrate 24, 31
Adaptive Load Compensation 44

Calibrate Sip and Puff 44
Calibration Screen 32, 44
Chair Configurations 42
Chair Log 62
Charge Cycles 63
Check for Updates 16, 25, 77
Clockwise Rotation 70
Commit Rule 67
Conditional Rules 64
Conditions 67
Conditions of Use 15
Configuration Summary 60, 66
Configuration Too Large 50
Connect 39, 42
Connection 38

Context 26
Open 38

Connection Context 43
Connection Context Tasks 39
Connection tab 25
Context Screen 38
Control Input 39, 64
Control Input Angle Sensor 70
Control IO 64
Control IO Slot 66
Controls 2, 12, 14, 24, 42, 91
Convert Configuration 24
Core Features 39, 48
Create Bundle File 24

GBK54033 LiNX Access PC
User Manual Issue 12

Index - Page 85

#$$index$$_Connection


GBK54033 LiNX Access PC
User Manual Issue 12

Creating A Bundle File 80
CSV 24

D

Deep Discharge Warnings 63
Default Chair Configuration 42
Delete a Profile 52
Diagnostics i, 2, 12, 40, 72
Discard 43
Discard Rule 67
Disclaimer 37
Disconnect 43
Display Settings 24
Distributing A Bundle File 82
Distributor 41
Distributor Access 46
Distributors 79
DLX-HKEY01-A 17, 41
DLX-HKEY02-A 17, 41
Drive 14

Statistics
Average Drive time 63
Average Motor Current 63
Drive Time 63
Maximum Left Motor Current 63
Maximum Left Motor Current

Time 63
Maximum Right Motor Current 63
Maximum Right Motor Current

Time 63
Powered Up Time 63
Time Near Maximum Current 64
Total Distance Travelled 64
Trip Distance 64

Drive Function 43
Drive Limits 39, 48
Drive Statistics 63
Drive Time 63
Driving / Battery Information 60
Drop-down List Operations 51
Duplicate Function 55
Dynamic 2, 12, 14, 91

E

Edit 24

Emergency Deceleration 39
Enable Input 68-69
Enter Firmware Upgrade Mode 25
Error and Event Logs 61
Event Code 61-62
Event Name 61-62
Events 60
Examples 31, 65
Export CSV 24

F

File 24, 38, 41-42, 49
Close 50
Context 28
Information 60
Modify 47
Name 41
Remove 50
Save 49

File Context Tasks 47
File Information 60
File tab 25
Firmware Upgrade 78
Forget Device 77
Forward 74
Forward Quadrant 74
Friendly Name 76
Function

Move 56
Functions 21, 39, 48

G

Gyro 24, 39
Gyro calibration 31-32
Gyro Limits 39, 48
Gyro Module 32, 43

H

Help 25
High Battery Events 63
Home 78

I

Import Firmware 24

Page 86 - Index

#$$index$$_Drive


IN 500 44
Indicators 39

Turn 39
Input Mode 74
Input Module 32, 44
Input Port Debounce 68-69
Input Type 66
Installation 14, 70
Internet Settings 25
Invalid Value 30

J

Jack Socket 65
Joystick shaping 24
Joystick Shaping 31, 45
Joystick Shaping Calibration 33

L

LAK (LiNX Access Key) 17, 25, 38
Language 14, 25
Last Charge Timestamp 63
Layout Overview 23
LCI Extension 41
Lighting 39, 48
LiNX Access Information 60
LiNX Access IOS Tool 72
LiNX Access Key 14, 17
LiNX Access Key (LAK) 17, 38
LiNX Access PC Tool 2, 12, 14, 19, 37
LiNX Access Tools 82
LiNX LE 43
Live Diagnostics 72
Live Edit 20, 26

Mode 20, 40
Parameter change indication 21

Load Compensation 24, 31, 44
Long Press 66
Low Battery Events 63

M

Main Content 31
Main Menu 24, 80
Manufacturer 41
Manufacturers 79
Maximum Left Motor Current 63

Maximum Left Motor Current Time 63
Maximum Right Motor Current 63
Maximum Right Motor Current Time 63
Memory Position 24
Menu bar

Calibrate 24
Edit 24
File 24
Help 25
View 24

Menu Bar 24
Mode 48
Modules 39, 48
Momentary 66
Monitored 68-69
Motions 24, 39, 46
Motor 24, 63
Motor Resistance 32
Mouse Mover 39
Move a Function 56

N

Navigation 23, 39
Navigation Restrictions 29
New Drive Function 53
New Mouse Mover Function 53
New Seating Function 53
New Utility Function 53
Normally Closed 68-69
Not Connected 26
Number of Charge Cycles 63
Number of Deep Discharge Warnings 63
Number of High Battery Events 63
Number of Low Battery Events 63
Numerical Operations 51

O

On Press 66
Open a file 38
Open Aa File 38, 47
Open Bundle File 24
Open File 24
Open the LiNX Access PC tool 37
Operating Mode 74
Output Action 67

GBK54033 LiNX Access PC
User Manual Issue 12

Index - Page 87

#$$index$$_Main%20Menu
#$$index$$_Mode
#$$index$$_Open%20a%20file


GBK54033 LiNX Access PC
User Manual Issue 12

Oversized configurations 50

P

Parameter
Edit 40, 48

Parameter Groups 39-40
Parameter Interface 45
Parameters 12, 20, 40
Park Brakes 12, 78
Performance 12, 21, 40
Port Settings 65
Positions 39, 48
Power 39, 91
Power Button 66
Power Module 31, 39, 44
Power ON 27
Powered

Off 26
Up Time 63

Powered Up Time 63
Primary Side Bar 30, 40, 48
Profile and Function Actions 52
Profiles 50
Program

Modify 39
Name 59

Changing 59
Read 40

Program 49
Read (from wheelchair) 41
Save As File 41
Write 40, 50

Program Name 26, 59-60
Programming i, 12, 17, 20, 37

Procedure 12
Proxy Server 17, 76

Q

Quit 24

R

Read 40
Remote Module 17, 39, 74
Requirements 14
Reserved 3

Reset Drive Statistics 64
Reset Log 62
Reset to Default 43
Resistor Bands 66
Restricted 66
Reverse 74

S

Save 24, 41, 49
Save As... 24, 41
Save To File 41
Search Box 30
Searching 64
Seating

Functions 53, 75
Secondary Side Bar 30, 40
Serial Number 25
Set Application Language 25
Short Press 66
Sip and Puff 24, 32, 44
Sip and Puff Calibration 31
Specifications 12, 14
Speedometer And Odometer 39
Stability 68
Stability Checking 68-69
Statistics 62-63
Status 12, 26, 61
Status Icon

Edit 26
Stop Driving and Seating 68
Store the Access Level Certificate 42
Support Request 25
Switch 40, 66

Operations 51
Switch Control 53

Function 53
Switches 22
System

Name 59-60
Changing 59

Summary 60
System Information 60

Viewing 60
System Name 29, 59
System Requirements 14

Page 88 - Index



System Summary 25, 78
Viewing 61

T

Tab Bar 20, 25
Tab Context 29
Template 53
Testing 20
Text-Based Operations 51
Time Near Maximum Current 64
Toolbar 26
Total Distance Travelled 64
Trigger Angle 24
Trigger Angles 39, 48
Trip Distance 64
Tune Adaptive Load Compensation

(ALC) 44
Tune the Gyro 43
Turn 39

U

Update 78
Update All 78
Update memory positions 46
Updates 25
User Function Navigation 39
User Input 44
User Input Configuration 44
User Preferences 39, 48
Utility 31, 53

Function 53-54
Utility Screens 31

V

Version 2, 12, 16, 24, 60
Versions 77
View 24
View as Distributor 24
View as Manufacturer 24
View Updates 78

W

Wheelchair Configuration 26
Whitelist 17

Windows Firewall 37
Windows Security Alert 37
Wireless Programming 12
Write 40

Z

Zero Point Offset 70

GBK54033 LiNX Access PC
User Manual Issue 12

Index - Page 89



GBK54033 LiNX Access PC
User Manual Issue 12

Page 90



Dynamic Controls HQ
39 Princess Street
Riccarton
Christchurch 8041
New Zealand

PO Box 1866
Christchurch 8140
New Zealand

Phone: +64 3 962 2519
Fax: +64 3 962 2966

Dynamic Europe Limited
Unit 7, Finepoint Way
Kidderminster
Worcestershire DY11 7FB
United Kingdom

GB VAT No. 487 3377 02,
Registered in England No.
2385287

Phone: +44 1562 826 600
Fax: +44 1562 824 694

All enquiries:
eusales@dynamiccontrols.com

North America
Phone: 1-855-207-9942

All enquiries:
sales@dynamiccontrols.com

Dynamic Controls Asia
(Taiwan)
Floor 4-2, No. 59,
Tien Hsiang Road
Chung Shan District Taipei
10452
Taiwan R.O.C.

Phone: +886 955 335 243
Fax: +886 225 981 562

All enquiries:
asiasales@dynamiccontrols.com

Dynamic Controls Asia
(China)
Phone: +86 512 6289 2847

All enquiries:
asiasales@dynamiccontrols.com

We are Dynamic

Dynamic is a world-leading
designer and manufacturer of
electronic controls for power
wheelchairs and scooters.

Find out about us

Resource Hub

Find product information
and downloads relating to
all our current products.

Need a resource? We have
you covered.

LiNX Knowledge Base

A collection of task-based
'how to...' articles,

concepts, application
notes and videos.

LiNX
Knowledge Base

www.dynamiccontrols.com

mailto:eusales@dynamiccontrols.com
mailto:sales@dynamiccontrols.com
mailto:asiasales@dynamiccontrols.com
mailto:asiasales@dynamiccontrols.com
https://www.dynamiccontrols.com/#aboutdynamic
https://www.dynamiccontrols.com/resource-hub
https://linxkb.dynamiccontrols.com/
https://www.dynamiccontrols.com/#aboutdynamic
https://www.dynamiccontrols.com/resource-hub
https://www.dynamiccontrols.com/resource-hub
https://linxkb.dynamiccontrols.com/
http://www.dynamiccontrols.com/

	1 Welcome
	1.1 Introduction
	1.2 Using this manual
	1.3 Important information
	1.4 Copyright, trademarks and acknowledgements
	1.5 Contents
	1.5.1 Contents Overview
	1.5.2 Contents Detailed

	1.6 Glossary

	2 Introduction to the LiNX Access PC tool
	2.1 What it does
	2.2 Features
	2.3 Version information
	2.3.1 The LiNX Access PC tool
	2.3.2 LiNX Systems


	3 Installation
	3.1 System requirements
	3.2 Installing the software
	3.3 Checking and getting the latest version
	3.4 The LiNX Access Key
	3.5 Using Bluetooth on a computer
	3.5.1 Using built-in Bluetooth
	3.5.2 Using an external USB Bluetooth adaptor


	4 A tour of the LiNX Access PC tool
	4.1 Programming contexts
	4.1.1 Viewing the contexts

	4.2 Modifying a program
	4.2.1 Live edit
	4.2.2 Bulk edit
	4.2.3 Working with live edit and bulk edit

	4.3 Screens, screen bars and menus
	4.3.1 Screen layout overview
	4.3.2 Menu bar
	4.3.3 Tab bar
	4.3.4 Toolbar
	4.3.5 Context tab mode
	4.3.6 Primary and secondary navigation sidebars
	4.3.7 Filter parameters box
	4.3.8 Main content area
	4.3.9 Utility screens


	5 How to...
	5.1 Open the LiNX Access PC tool
	5.2 Select the context
	5.3 Connection context tasks
	5.3.1 Connect to a wheelchair
	5.3.2 Modify a program
	5.3.3 Write a program to a wheelchair
	5.3.4 Read a program from a wheelchair
	5.3.5 Save a program as a file
	5.3.6 Authorise computer (store the Access Level Certificate)
	5.3.7 Manage chair configurations
	5.3.8 Disconnect from a wheelchair
	5.3.9 Tune the gyro
	5.3.10 Tune adaptive load compensation (ALC)
	5.3.11 Calibrate sip and puff
	5.3.12 Joystick shaping
	5.3.13 Update memory positions

	5.4 File context tasks
	5.4.1 Open a file
	5.4.2 Modify a file
	5.4.3 Save a file
	5.4.4 Read a program from a wheelchair
	5.4.5 Write a program to a wheelchair
	5.4.6 Close a file
	5.4.7 Remove a file from the file list

	5.5 Common tasks
	5.5.1 Edit and modify parameters
	5.5.2 Profile and function actions
	5.5.3 Add and remove components
	5.5.4 Change the system and program name
	5.5.5 View system information
	5.5.6 View the system summary
	5.5.7 View the error and event logs
	5.5.8 View statistics
	5.5.9 Searching

	5.6 Configure control inputs and outputs (control IO)
	5.6.1 Select and configure an input
	5.6.2 Configure an always rule
	5.6.3 Configure a conditional rule
	5.6.4 Configure advanced settings

	5.7 Configure memory positions
	5.7.1 Overview
	5.7.2 Step 1 - Install modules
	5.7.3 Step 2 - Create servos
	5.7.4 Step 3 - Create memory position
	5.7.5 Step 4a - Configure a control input
	5.7.6 Step 4b - Configure seating function

	5.8 Tool utilities
	5.8.1 Configure Internet settings
	5.8.2 Set friendly name
	5.8.3 Forget device
	5.8.4 Check for new version
	5.8.5 Upgrade firmware
	5.8.6 View as manufacturer or distributor

	5.9 Manage configurations and firmware with bundle files
	5.9.1 Creating a bundle file
	5.9.2 Distributing a bundle file
	5.9.3 Viewing the contents of a bundle file
	5.9.4 Programming from a bundle file


	6 Index

